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Lag et nytt EndNote-bibliotek

Nar du apner EndNote Desktop for fgrste gang, far du en gra skjerm med en menylinje pa toppen.

For & ta programmet i bruk, trenger du et bibliotek, som kan opprettes ved a klikke pa File > New. Gi

biblioteket et navn og klikk Lagre/Save. Det nye biblioteket apnes automatisk.

=  For a apne et eksisterende bibliotek, ga til File > Open Library... og finn frem biblioteket ditt.

= Et EndNote-bibliotek bestar alltid av en EndNote-fil med bibliotekets navn (f.eks. Endnote) og en
mappe med samme navn (Endnote.Data). De to delene ma alltid lagres sammen for at biblioteket
skal fungere problemfritt.

=  For a lage en sikkerhetskopi av biblioteket i en komprimert fil: Ga til File > Compressed Library
(.enlx), og velg hva som skal vaere med i biblioteket. Klikk pd Next/OK for a lagre filen p& gnsket
sted.

Layout

Apner du et nytt bibliotek, vil skjermbildet se slik ut:

@ EndNote X8 - [Test) - o x

@ File Edit References Groups Toels Window Help e - &8 x

D @ E A""D“t‘d@ L [ ; E‘} ‘3«{ g L I—Ef ‘_;E '-./_.;' J_F:* - iz}] Quitk Search @ Q = 3% Show Search Panel

My Library | ® & Author b Year Title Rating l Reference | Preview |™L Attached POF ] ™~
Reference Type: - f +

=} Configure Sync... ® =

D Recently Added 0 No References Selected

B unfiled (]

T Trash © @

= My Groups

= Find Full Text

Showing 0 of O references. ||E Layout -

1 —Valg av modus: Lokalt bibliotek, online-sgk, lokalt bibliotek + online-sgk

2 — Referanseoversikt

3 — Gruppepanel: Viser gruppene biblioteket er inndelt i

4 — Referansepanel: Visningsfelt for markert referanse

5 — Visningsvalg for referansepanel: Referansedetaljer, forhandsvisning i henhold til valgt stil, og
vedlegg (vanligvis fulltekst i PDF-format)

6 — Layout: Velg posisjonering og utforming av referansepanelet

7 — Kolonneoversikt. Hgyreklikk for a velge hvilke kolonner som vises

8 — Verktgylinje: Se lenger nede for beskrivelse av funksjoner

9 — Valgmeny av referansestiler



Eksempel pa bibliotek i Bottom — Split layout:

@ EndNote X8 - [My EndNote Library] - [m] X
@ File Edit References Groups Tools Window Help - & x
& ‘ Annotated - El AR ] ‘ | [»] 3 wE ‘ Q S -| @‘ Quick Search Q ~ % Show Search Panel
My Library ‘ ® & Author Year Title Rating Journal Last Updated ~ Reference Type &
A - o L Hattori, Heather.. 2014 Chemistry 1,001 chemistr.. 19.04.2017 Book
H i N Spesialh : del
EEDuplicate References (&) | ® I 2017 p i 2 19.05.2017  Web Page
@ [ ] Heussel, Claus .. 2008 Pulmonary Infection Encyclopedia o... 25.04.2017 Encyclopedia
BE SES ® Holland, F; Brag.. 1995  Fluid Flow for Chemical and Process Engineers Chemistry 19.04.2017  Book
DRecently Added @ Hov. Jo 1993 Avtalerett s s+ o+ s 16.05.2017  Book
B unfiled 63) @ Hiberg, Liv Ingri.. 2016  Didaktikk i ein barnehagekontekst Barnchagefolk  16.05.2017  Journal Articdle
TET Trash ™ |® Izzo, Angelo A; E.. 2009 Interactions between herbal medicines and pr... Drugs 04.05.2017 Journal Article
_ L] Jacobs, David M... 2017 Prevalence of and outcomes from Staphylococ... American Jour...  16.05.2017 Journal Article
ST ®  JiV:ChenS;Xi. 2017 Sirolimus for the treatment of progressive ka... Int J Cancer 15.052017  Journal Article
E_! Bygg @ e Kim, Wansoub; L. 2016 Evaluation of lifting efficiency of double-cage ... 33rd Internatio.. 16.05.2017 Conference Pr...
H-de\mg 5 |® Klaebo, Lars Gun... 2017 Myocardial strain-analysis Hjerteforum 26.05.2017 Journal Article
B Elektro o |® Klima- og miljed... 2017  Oppdatering av forvaltningsplanen for Norske... 26.042017  Government D...
v (5) [ ] P 2011 R plan for barnehagens innhold og oppga... 26.04.2017 Report
E_! Kemi @ [ ] Lai, Goh 2010 Follow the Chemistry : Lure, Lore and Life - An ... Chemistry 19.04.2017 Book
emi
=) £ - [ ] Lands, Larry C; St... 2016 Oral non-steroidal anti-inflammatory drug the... Cochrane Data... 16.05.2017 Electronic Artic...
= Medisin ©) l®  LiDW;Zhow L 2017  Improving low-pressure CO2 capture perform.. Carbon 18.042017  Journal Article
=~ My Groups [ ] Lolas Hamameh, ... 2017  Genomic analysis of inherited breast cancer a... Int J Cancer 15.05.2017 Journal Article v
Bl Eisempel () Reference | Preview =1 Attached PDFs @ L4
% New Smart Group  (3) >
~
Reference Type: Book - {'E‘ M - |
[=)- Find Full Text
e Rating There are no PDFs attached to this reference.
Author
Hov, Jo
Year
1993
Title
Auvtalerett
Place Published
Oslo
L e
Showing 82 of 82 references. @ Layout =

EndNote verktgylinje
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1. Kopier referanse fra et online-sgk til det lokale biblioteket
2. Legg til en ny referanse manuelt

3. Online-spk

4. Importer referanser fra en fil

5. Eksporter referanser

6. Sopk etter fulltekst online

7. Apne fgrste lenke som er oppfgrt i referansen

8. Apne referansens vedlegg

9. Sett inn markerte referanser i Word

10. Formater litteraturlisten i en bestemt stil

11. Gatil Word

12. Synkronisering av EndNote Desktop biblioteket med EndNote Online biblioteket
13. Del biblioteket med andre EndNote-brukere

14. Meldinger om nylige forandringer i biblioteket

15. Hjelp




Legg nye referanser til biblioteket

Det finnes flere mater a samle referanser i EndNote. Man kan eksportere referanser fra fagdatabaser
ved a laste ned en referansefil, man kan sgke i databaser via EndNote, eller man kan legge inn
referanser manuelt.

Eksporter referanser fra en database

For a eksportere referanser fra en fagdatabase til EndNote, fglger du som regel disse stegene:

1) Sgk etter et emne i en relevant database

2) Kryss av for en eller flere aktuelle artikler i trefflisten

3) Klikk pa en knapp eller lenke med navnet cite, send to, download eller export.
4) Last ned referansene i EndNote- eller RIS-format.

5) Dobbelklikk pa filen for @ apne den i EndNote.

Ting kan ga galt under import av referansene. Opplysninger kan havne feil i felt, og de kan ogsa vaere
registrert feil. Du bgr derfor alltid korrekturlese referansene du har lastet inn.

Nedenfor finner du to eksempler for referanseeksport til EndNote, fra Oria og Google Scholar.
Se hvordan du eksporterer referanser fra andre databaser pa bibliotekets EndNote hjelpesidene
(«Eksport av referanser fra databaser til EndNote Desktop»).

Eksport fra Oria:
1) Sgk opp referansen du vil overfgre

2) Klikk pa fanen Send til
3) Klikk pa EndNote

Metode og oppgaveskriving
7" % Olav Dalland 1940-
7 2017
@ Tilgjengelig fra Hegskolen i Bergen

Finn og bestill  Detaljer ~ Omtaler & tagger  Virtuell hylle Send til

Bok

» Leggilagrede treff
» E-post
o Skriv ut
» Permalenke
+ Referanse

« HefiVorks

« Delicious
» Eksport RIS
» EndNote Web
» Export BibTeX

4) Klikk OK i vinduet som apner seg (du trenger ikke a forandre innstillingene)
5) Lagre filen og/eller apne den med EndNote
6) Korrekturles den overfgrte referansen



For a redigere referansen, markerer du den i biblioteket for a apne den i referansepanelet.
Klikk deg inn i feltet som skal redigeres. Klikk pa File > Save (Ctr/+S) for & lagre endringene.

Reference | Preview | ™% Attached PDFs @ ¥

~
Reference Type: Book - {E -

Author
Dalland, Olawv

Year

2017

Title

Metode og oppgaveskriving

Series Title

Metode og oppgaveskriving for studenter

Place Published
QOslo

Publisher
Gyldendal akademisk

Edition

6. utg.

ISBN
978-32-05-50070-9
Keywords
Akademnisk skriving

Samfunnsvitenskap
Metoder

| eksempelbildet over star en referanse eksportert fra Oria til EndNote. | referansen kom
utgaveinformasjonen med pa norsk (utg.). | EndNote legger referansestilene automatisk til
utg. pa norsk eller ed. pa engelsk, og dette skal derfor ikke vaere med i referansen. | feltet
Edition skal det bare sta selve tallet. Feltet Series Title skal vaere tomt.

For & velge om tomme felt skal vises i referansepanelet, klikk pd tannhjulsymbolet

i hjgrnet av referansepanelet og aktiver/deaktiver Show Empty Fields.

Eksport fra Google Scholar:

1)
2)

3)

Sek opp referansen du gnsker a overfgre
Klikk pa Referanse/Cite

The effect of corrosion on the structural reliability of steel offshore structures
RE Melchers - Corrosion science, 2005 - Elsevier

This paper considers essential theoretical concepts and data requirements for engineering

structural reliability assessment suitable for the estimation of the safety and reliability of

corroding ships, offshore structures and pipelines. Such infrastructure operates in a harsh

Sitert av 130 Beslektede artikler Alle 7 versjoner Web of Science: 68' Referansel Lagre

| det nye vinduet, klikk pa EndNote



Referanse

Kopier og lim inn et formatert sitat, eller bruk en av linkene for & importere til en
bibliografibehandler.

MLA  Melchers, Robert E. "The effect of corrosion on the structural reliability of steel
offshare structures.” Corrosion science 47.10 (2005): 2391-2410.

ARA - Melchers, R. E. (2005). The effect of corrosion on the structural reliability of
steel offshore structures. Corrosion science, 47(10), 2391-2410.

[S0 690 MELCHERS, Robert E. The effect of corrosion on the structural reliability of
steel offshore structures. Comosion science, 2005, 47.10: 2391-2410.

BibTeX |EndNote| Reflan  RefiVorks

4) Lagre filen og/eller apne den med EndNote Desktop
5) Korrekturles den overfgrte referansen

Sek i fagdatabaser via EndNote (Online Search Mode)

| Online Search Mode kan du sgke etter referanser direkte i EndNote, uten at du ma dpne databasen
i nettleseren din. En del sgkefunksjoner fra fagdatabasen vil mangle, sa Online Search Mode
anbefales bare for & sgke opp helt bestemte referanser, ikke for selve litteratursgket.

1) Bytt til Online Search Mode @

2) Velg databasen i sidepanelet som du vil sgke i (f.eks. PubMed, Web of Science, LOC)
Klikk pa more... om du ikke ser gnsket database i listen

3) Fyll ut en eller flere sgkefelt og klikk pa Search

4) Kopier referansene til biblioteket ved a markere dem i trefflisten og klikke pa

Copy to Local Library

= NB: Mange databaser krever palogging, og vil veere utilgjengelige for bruk

Legg inn referanser manuelt

Referanser for bgker og tidsskriftsartikler kan du stort sett eksportere fra Oria eller fagdatabaser til
EndNote. For en del andre kilder er det ngdvendig a legge inn referansen manuelt, f.eks. nettsider,
avisartikler, lover og forskrifter, rapporter, retningslinjer eller bilde- og lydmateriale.

1) Ga til References > New Reference (Ctr/+N) eller klikk pa Ei

2) Velg passende Reference Type og fyll ut de ngdvendige feltene
3) Lagre referansen ved a ga til File = Save (Ctr/+S)

4) Lukk referansen. Referansen finner du igjen under All References

For a finne passende Reference Type for kilden du bruker og for a sjekke hvilke felt som ma fylles ut,
kan du se pa eksempelsamlingene pa bibliotekets EndNote-hjelpesider.



Noen eksempler pa referanser som er lagt inn manuelt:

= Lov

Reference | Preview |™L Attached PDFs (f/; hd

Reference Type: Legal Rule or Regulation ~ {El -

Author

Avhendingslova,

Year

1992

Title

Lowv av 3. juli 1992 nr 93 om avhending av fast eiendom

URL
https://lovdata.no/dokument/MNL/Tow/1992-07-03-93

= Nettside

Reference | Preview ‘1_ Attached PDFs | @ ¥

Reference Type: Web Page = {EI -

Author

Helsedirektoratet,

Year

207

Title

Mekkeltall: Spesialhelsetjenesten del 2
Place Published

Oslo

Publisher

Helsedirektoratet

Access Date

18, mai 2017

Last Update Date

23. februar 2017

URL
https://helsedirektoratet.no/statistikk- og-analyse/nokkeltall/nokkeltall-

for-spesialisthelsetjenesten/nokkeltall-spesialisthelsetjenesten-del-2

= Standard

Reference | Preview |™ Attached PDFs | @ -

Reference Type: Standard - 'r‘lil -
Institution

Standard MNorge,

Year

2015

Title

Eurckode 3: Prosjektering av stilkonstruksjoner - Del 1-1: Allmenne
regler og regler for bygninger

Place Published

Oslo

Publisher

Standard Morge

Document Number
MS-EM 1993-1-1:2005+ A1:2014+ NA: 2015




= NB: Feltet Author fylles vanligvis fylles ut i formen:
Etternavn, Fornavn
Organisasjonsnavn som bestar av flere enn ett ord ma fgres inn med komma etter, for a unnga at
navnet inverteres som et personnavn. For eksempel:
Hggskulen pa Vestlandet,

EndNote og Word

Nar EndNote er installert, vil du finne verktgylinje i Word med navn «EndNote X8». Denne bruker du
til a sette inn referanser fra biblioteket ditt, velge @nsket referansestil og for a tilpasse
referansehenvisningene i teksten.

Sett inn referanser

Sett markgren der du gnsker referansen, og klikk Insert Citation i EndNote-verktgylinjen

1)

Sett inn Utforming Oppsett Referanser Masseutsendelser Se gjennom Visning EndNote X8

Style:  HVL-APA 6th bokmaal -
I_E,l Update Citations and Bibliography
B2, Convert Citations and Bibliography -

Hjemn

ﬁx- Categorize References - Export to EndMote -

Instant Formatting is On =

@ Goto EndNate

* Edit anage Citation(s
% Edit & Manage Citation(s)
E‘ﬁ. Edit Library Reference(s)

@

Insert
Citation 7)

-—
= Preferences

eHelp

Tools

Citations Bibliography P}

2) Sek etter referansen du vil sette inn, f.eks. pa forfatter, ord i tittel eller arstall.
EndMote X8 Find & Insert My References >
|| jacobs v| Find ]
Author Year Title

Jacobs 2017  Prevalence of and outcomes from Staphylococous aureus pneum)

< >
Reference Type:  Journal Article ~
Record Number: 52
Author: Jacobs, David M.
Shawer, Amy
Year: 2017
Title: Prevalence of and outcomes from Staphylococous aureus
pneumonia among hospitalized patients in the United
States, 2009-2012
Journak American Journal of Infection Control
Volume: 45
Issue: 4
Pages: 404-409
ISSH: 0196-6553 v
Cancel Help
Library: My EndMote Library.enl litems in list




3)

Velg

Med et klikk pa Insert setter du inn en henvisning i teksten, og referansen blir lagt til
i litteraturlisten pa slutten av dokumentet.

= Hvis du bruker en forfatter-arstall-referansestil, kan du i nedtrekksmenyen av Insert
velge om du vil ha bade forfatter og arstall (Insert), bare arstall (Insert & Exclude Author)
eller bare forfatter (Insert & Exclude Year) med i teksten.
Du kan ogsa bare legge til referansen i litteraturlisten (Insert in Bibliography Only),
eller sette forfatteren utenfor parentes (Insert & Display as: Author (Year))

Cancel Help

Insert

Insert & Display as Author (Year)
Insert & Exclude Author

Insert & Exclude Year

Insert in Biblicgraphy Only

= Alternativ kan du bytte til EndNote, finne fram referansen(e) du vil sette inn, og klikke pa
symbolet IE' .
referansestil og design av litteraturlisten

Velg referansestil i stilmenyen.
Klikk Select Another Style... for a finne installerte stiler som ikke er i listen.

Hjem Sett inn Utfarming Oppsett Referanser Masseutsendelser Se gjennom

|,,(1| @ Goto EndNote | Style  HVL-APA 6th bokmal 'I ﬁx— Categorize References =

E_'}‘ Edit & Manage Citation(s) LE,' Update Citations and Bibliography Instant Formatting is On -
Citation = E‘ﬁ. Edit Library Reference(s) E-', Convert Citations and Bibliography ~

Citations | Bibliography )

Du kan tilpasse font, skriftstgrrelse, innrykk, linjeavstand og avstand mellom
referansene i litteraturlisten under Blibliography 2 Layout

EndMote X8 Configure Bibliography b4
Format E!il::liogra|:»h5«I
Font: Size:

Bibliography title:

Text Format...

Start with bibliography number:

First lime indent: | 0.000 cm Line spadng: | Single “
Hanging indent: Space after:  |None ~

worye | [ o




Rediger og slett henvisninger

For a redigere referansene i et Word-dokument, bruker du funksjonen Edit & Manage Citation(s).
NB: Ikke skriv direkte inn i formaterte EndNote-felt! Det vil fgre til at endringene tilbakestilles
eller at formateringen gar tapt.

Hjem Sett inn Utfarming Oppsett Referanser Masseutsendelser Se gjennom

(1] @ Goto EndMote Style: |HVL-APA 6th bokmal - Eﬁ- Categorize References -
| [E‘}‘ Edit & Manage Citatiu:un[s]] E.' Update Citations and Bibliography Instant Formatting is On -
nsert

Citation = E}'} Edit Library Reference(s) B2, Convert Citations and Bibliography -

Citations Bibliography Fa

= Det apnes ett nytt vindu med en oversiktsliste over referansene i dokumentet.

EndMote X8 Edit & Manage Citations ht

-~

Citation Count  Library

(Hato et al., 2017)

. . Hato, 2017, Developm... GV NG el Edit Reference | -
(Meyer, 2017) C/D

Meyer, 2017 #15 1 Traveling Library Edit Reference | =

(Standard Morge, 2015)

Standard Norge, 2015... 1 Traveling Library Edit Reference | =
(Lietal., 2017)

Li, 2017 #13 1 Traveling Library Edit Reference | =
(Clauser, 1356; Hategeka, Shaveller, Tuyisenge & Lynd, 2017) w

Edit Citation Reference

l Formatting: | Default Vl B
Prefix:
Suffix:
A
Tools - Cancel Help

Totals: 24 Citation Groups, 30 Citations, 30 References

A) Legg til sidetall

= | feltet Pages kan du legge inn sidetall for henvisningen i teksten. Dette gjelder for den
aktiverte henvisningen, og vil ikke pavirke andre instanser.

= Noen stiler stgtter ikke sidetall direkte, og da ma du legge det inn med Suffix istedenfor
Pages.
Pages = Skriv inn bare tallet
Suffix = Skriv inn «, s. sidetall»

= Klikk OK nar du er ferdig med redigering av referansen.

Eksempel:
For redigering: (Myhre, Marshburn & Toverud, 1989)
Etter redigering: (Myhre, Marshburn & Toverud, 1989, s. 48)



B) Fjern forfatternavn eller arstall fra henvisning in teksten

Under Formatting kan du velge om du vil ha forfatter og arstall med
i referansehenvisningen.

Edit Citation Reference

Formatting: |Default e
Prefix: Display as: Author (Year)
Exclude Author
Suffix: Exdude Year
Exdude Author & Year
Pages: Show Only in Bibliography

Klikk OK nar du er ferdig med redigering av referansen.

C) Legg til en referanse pa samme sted som en eksisterende

Klikk pa Edit reference og velg Insert Citation.

(Hato et al., 2017)

. . Hato, 2017, Developm... 1 Traveling Library [ iAciaiaane
(Meyer, 2017) Edit Library Reference
Meyer, 2017 #15 1 Traveling Library Find Reference Updates...

(Standard Morge, 2015) Remave Citation

Standard Morge, 2015... 1 Traveling Library Insert Citation

Lietal, 2017) Update from My Library...

Klikk OK nar du er ferdig med redigering av referansen.

D) Slette referanser

Klikk pa Edit reference og velg Remove Citation.

(Hato et al., 2017)

. . Hato, 2017, Developm... 1 Traveling Library  [FRidciaiaaane
(Meyer, 2017) Edit Library Reference

Meyer, 2017 #15 1 Traveling Library Find Reference Updates...
(Standard Morge, 2015) Remove Citation
Standard Morge, 2015... 1 Traveling Library Insert Citation

Update from My Library...

(Lietal., 2017)

Klikk OK nar du er ferdig med redigering av referansen.
Henvisningen til referansen er na slettet fra dokumentet. Referansen ligger fremdeles i
biblioteket.
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Oppdatering, formatering og konvertering av referanser i Word
A) Oppdatere referanser
Nar du redigerer referanser i EndNote-biblioteket, ma de oppdateres i Word-dokumentet.

Dette gjgres automatisk innimellom, men kan gjgres manuelt ved a klikke pa Update
Citations and Bibliography. Denne funksjonen finner du rett under stilmenyen.

Hjem Sett inn Utforming Oppsett Referanser Masseutsendelser Se gjennom

95 @ Goto EndNote Style: | HVL-APA 6th bokmal - @- Categorize References ~
P E‘} Edit & Manage Citation(s) [ LE,' Update Citations and Bibliography ] Instant Formatting is On ~
Citafion = E‘g; Edit Library Reference(s) B Convert Citations and Bibliography ~

Citations Bibliography P

B) Avformatere referanser

Skal du flytte tekstavsnitt som inneholder EndNote-referanser eller slad sammen flere
dokumenter, bgr du avformatere referansene fgr du klipper og limer. Da vil Word arbeide
raskere. | sjeldne tilfeller kan kopiering av formaterte EndNote-referanser medfgre feil.

= Klikk pa Convert Citations and Bibliography = Convert to Unformatted Citations

Fil Hjem Settinn Utforming Oppsett Referanser Masseutsendelser Se gjennom
53 @ Go to EndMote Style: Annotated - iﬁ- Categorize References =

| E’,“Edit&Manage Citation(s) E‘ Update Citations and Bibliography Instant Formatting is On =
nsert
Citation = E‘; Edit Library Reference(s) 2, Convert Citations and Bibliography -

Citations [ lZ_'.'.‘ Convert to Unformatted Citations ] E

3} Convert to Plain Text

Py Convert Reference Manager Citations to EndNote

~ ﬂ! Convert Word Citations to EndMote

Som resultat kommer EndNote-kodene fram og litteraturlisten forsvinner.

(Myhre, Marshburn & Toverud, 1989, s. 48) = {Myhre, 1989, Patologi @48}

Klikk pa Update Citations and Bibliography for a fa referansene tilbake til formatert form.

C) Konverter referansene til tekst

Det er mulig a opprette et Word-dokument hvor forbindelsen til EndNote er brutt. Her kan
du gjgre siste finpuss i referansene. Dette burde vaere det siste man gjor fgr eventuell lagring
som PDF eller fgr man sender dokumentet fra seg.

NB: Ta vare pa det opprinnelige dokumentet, der EndNote-kodene er intakt. De kan ikke
gjenopprettes i det nye dokumentet.

= Klikk pa Convert Citations and Bibliography - Convert to Plain Text

11



Fil Hjemn Sett inn Utforming Oppsett Referanser

53 @ Go to EndNote Style: | Annotated
e lZ_',’, Edit & Manage Citation(s) LE,' Update Citations and Bibliography
Citation = E;';: Edit Library Reference(s)

Citations Convert to Unformatted Citations

2
G [E" Convert to Plain Text ]
R

Convert Reference Manager Citati

Masseutsendelser

Se gjennom

- @- Categorize References -
Instant Formatting is On =

%, Convert Citations and Bibliography -

ons to EndNote

~ EH Convert Word Citations to EndMote

Organiser EndNote-biblioteket

Organiser biblioteket i grupper

Du kan holde orden i biblioteket ved & legge referansene i grupper.

= Custom groups:

For a lage en ny gruppe, ga til Groups = Create group. Den nye gruppen finner du igjen under
My Groups i gruppepanelet. Du kan gi et navn til gruppen ved a hgyreklikke pa den og velge

Rename Group. For a legge en referanse i gruppen, drar du referansen fra listen i All References

til gruppen i gruppepanelet.

=  Smart groups:

Smartgrupper samler referansene etter gitte kriterier. For a lage en ny smartgruppe, ga til

Groups = Create Smart group. Det apnes et nytt vindu i det du kan velge et navn for gruppen og

sette kriterier for referansene. Du kan f.eks. sgke etter forfatter, arstall, opprettelsesdato,

database eller ngkkelord. Klikk Create for & opprette smartgruppen.

Smart Group

Smart Group Name: |New Smart Group

|Author V| | Contains V| |
|And V| |‘r'ear V| | Contains V| |
[nd ~||Title ~|[ contains “

Options...*

[IMatch Case [ ]Match Words

Slette dubletter

For a unnga stg@y fra referanser som er importert flere ganger, kan du sjekke biblioteket ditt for
dubletter. Ga til References - Find Duplicates. Finnes det dubletter i biblioteket ditt, apnes det et

vindu der du kan sammenligne dublettene. Velg referansen du vil beholde ved a klikke pa Keep This

Record.
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Legg til fulltekst

Har du lagret fullteksten til en artikkel, kan du knytte den til referansen i EndNote-biblioteket ditt.
Legg ved en PDF ved 3 klikke pa den aktuelle referansen i EndNote og & klikke pa binders-symbolet i
referansepanelet.

™" Attached PDFs @'

There are no POFs attached to this reference.

"y
LY,

Finn fulltekst pa nett

EndNote kan ogsa sgke opp fulltekst pa nett. EndNote gjgr da et oppslag basert pa DOl og andre
opplysninger i referansen. Man kan ogsa gjgre oppslag i Oria, med OpenURL Link. Dette krever
registrering av HVLs OpenURL-server:

Ga til Edit > Preferences - Find Full Text
Skriv HVLs OpenURL i feltet OpenURL Path:
http://openurl.bibsys.no/openurl

EZProxy-serveren settes inn i feltet Authenticate with: URL:

https://login.galanga.hvl.no/login?

EndMote Preferences

- Change Case

- Display Fields

- Display Fonts

- Duplicates

.. Folder Locations
- Formatting

. Libraries

- PDF Handling

.. Read / Unread

- Reference Types
- Sorting

- Spell Check

- Sync

. Temporary Citations
- Term Lists

.. URLs & Links

The Find Full Text feature uses several technologies to madmize the
chances that EndNote will find all available PDFs. Use this screen to
control these full text search options:

[+ Web of Science Full Text Links

DO (Digital Object |dentifier)

PubMed LinkOut (U.5. National Library of Medicine)

OpenURL

[OpenUHL Path: | |
Autherticate with:

[URt | |

Bxamples: https:/Aogin.ezprowy library myuniversity edu/login
hittp://auth universityname edu/authentication

[] Automatically invoke Find Full Text on newly-mported references

EndMote Defaults

Revert Panel Avbryt

Bruk

Marker referansene du gnsker fulltekst til, og klikk pa Find Full Text:

&

Fullteksten som blir funnet

pa nett blir na lastet ned og knyttet til referansen i biblioteket. Referanser med fulltekst er merket
med et binders-ikon.
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Synkroniser biblioteket med EndNote Online

Du kan synkronisere EndNote-biblioteket med en online-konto via Sync funksjonen. Dette gjgr det
lettere 3 fa tilgang til biblioteket fra andre datamaskiner, og du kan jobbe med biblioteket hvor og
nar du vil, sa lenge du har tilgang til internett. Du kan enten opprette en konto for EndNote Online

pa siden https://myendnoteweb.com, eller ved & klikke pa Sync O . Om du setter opp andre
datamaskiner til & synkronisere mot den samme kontoen, vil de kunne benytte samme bibliotek.
Biblioteket er ogsa tilgjengelig i EndNote Online.

For mer informasjon om EndNote online, se «Kom i gang med Endnote online» pa bibliotekets
EndNote-hjelpesider.

Del biblioteket

| EndNote Desktop kan du dele et helt bibliotek, og kun ett. Klikk File = Share (eller Share Library

i
== ). Om du ikke har satt opp synkronisering, tar EndNote deg f@rst giennom denne prosessen. For

a dele biblioteket, fgrer du inn epost-adressene for samarbeidspartnerne i det midterste feltet i
Sharing-vinduet (Invite More People). Klikk Invite, sa blir det sendt delingsinvitasjoner pa epost.
Mottakerne far en lenke til EndNote Online, og etter a ha logget seg inn, vil de finne igjen det delte

biblioteket i EndNote Desktop under File = Open Shared Library..., forutsatt at EndNote Desktop er

synkronisert til den samme kontoen.
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Om du ikke finner gnsket referansestil i EndNote stilsamlingen

Last ned referansestiler

Det finnes en rekke forskjellige stiler til nedlasting pa EndNotes nettsider. Du kan ogsa finne norske

referansestiler pa nettsidene til hgyskole- og universitetsbibliotek i Norge.

Har du lastet ned en referansestil fra nett, installerer du ved a dpne filen, og deretter lagre den: File

-> Save As... Velg et navn for stilen og klikk Save.

Se lenkene under «Referansestiler» pa bibliotekets EndNote-hjelpesider for referansestiler tilpasset

for HVL.

Redigering av eksisterende referansestiler

Vil du tilpasse en referansestil, f.eks. endre forkortelser, er det enklest a redigere en eksisterende stil.

1) Ga til Edit > Output Styles > Open Style Manager...

| oversiktslisten av stiler kan du krysse av stilene som vises i stiimenyen i EndNote og Word.

2) Marker stilen du gnsker a redigere og klikk Edit
3) Tilpass det du gnsker og avslutt med File = Save As...

Noen vanlige redigeringsmuligheter:

= Velg om tidsskrifttittel skal forkortes:
Journal Names
=  Bytte ut engelske mot norske ord (and til og) i referansehenvisning:
Citations - Author Lists
= Bytte ut engelske mot norske forkortelser for sidetall:
Citations > Templates: erstatt «p.» med «s.»
Bibliography > Templates: erstatt «p.» med «s.»

= Det meste av stilen er definert under Bibliography = Templates. Her er det definert hvilke
EndNote-felt som skal vises for de forskjellige referansetypene i litteraturlisten. Skal du

redigere noe her, bgr du vaere veldig ngyaktig med tegnsettingen for a fa en feilfri
referansestil! For a legge til et nytt felt, klikk pa Insert Field og velg aktuell felt.
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Andre nyttige funksjoner i EndNote

Quick Search

Du kan bruke funksjonen «Quick Search» for a finne fort frem til en bestemt referanse i biblioteket.

2 B W[ (O L “u -

®‘ Quick Search Q. = | ¥ Show Search Panel

PDF-redigering

Det er mulig redigere PDF-filer knyttet til referanser i EndNote, f.eks. markere eller understreke
tekstpassasjer, legge til notater, etc.

Tittelregister for tidsskrifter

Noen databaser eksporterer referanser med forkortet tidsskrifttittel, og noen referansestiler krever
full tittel — og omvendt. EndNote kan oversette mellom kort og fullstendig tittel, og kommer med
ferdige tittelregistre for ulike fagomrader:

1) Gatil Tools 2 Open Term Lists 2 Journal Term List

2) Marker alle termer i listen og klikk pa Delete Term

3) Bytt til fanen Lists og klikk pa Import List...

4) Velg en aktuell liste (bare én) og klikk Apne for & importere listen

Importer referanser fra PDF

EndNote har en funksjon for a importere referanser basert pa fulltekstartikler i PDF format. Dette vil
som regel bare fungere for nyere PDF-er med DOI.

= Import av en enkelt PDF-fil:

1) Ga til File > Import - File...

2) Klikk pa Choose... og finn frem PDF-filen du vil importere
3) Velg Import Option: PDF

4) Klikk pa Import

= Import av en mappe med PDF-filer:

1) Ga til File > Import = Folder...

2) Klikk pa Choose... og finn frem mappen med PDF-filene du vil importere

3) Velg Import Option: PDF

4) Kryss av for «include files in subfolders» om du vil ogsa importere filer i undermapper
5) Klikk pa Import
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